Installation Guide

ACT! by Sage 2010 &
ACT! by Sage Premium 2010



ACT! by Sage 2010 & ACT! by Sage Premium 2010

Installation Guide

Copyright © 2009 Sage Software, Inc. All Rights Reserved.

Sage, the Sage logos, ACT! and the Sage product and service names mentioned
herein are registered trademarks or trademarks of Sage Software, Inc. or its
affiliated entities. Microsoft SQL Server, Windows Vista and the Windows Vista
logo are trademarks or registered trademarks of Microsoft Corporation in the
United States and/or other countries. All other trademarks are the property of
their respective owners.

Released 8/2009 for ACT! by Sage 2010 and ACT! by Sage Premium 2010
Version: UA386

This material may not, in whole or in part, be copied, photocopied, reproduced,
translated, or reduced to any electronic medium or machine-readable form
without prior consent in writing from Sage Software, Inc., 1715 North Brown
Road Lawrenceville, GA 30043 ATTN: Legal Department.

ALL EXAMPLES WITH NAMES, COMPANY NAMES, OR COMPANIES
THAT APPEAR IN THIS MANUAL ARE FICTIONAL AND DO NOT REFER
TO OR PORTRAY IN NAME OR SUBSTANCE ANY ACTUAL NAMES,
COMPANIES, ENTITIES, OR INSTITUTIONS. ANY RESEMBLANCE TO
ANY REAL PERSON, COMPANY, ENTITY, OR INSTITUTION IS PURELY
COINCIDENTAL.

Every effort has been made to ensure the accuracy of this material. However,
Sage Software, Inc. makes no warranties with respect to this documentation and
disclaims any implied warranties of merchantability and fitness for a particular
purpose. Sage Software, Inc. shall not be liable for any errors or for incidental or
consequential damages in connection with the furnishing, performance, or use of
this material or the examples herein. The information in this material is subject to
change without notice.

End User License Agreement

This product is protected by an End User License Agreement. To view the
agreement, go to the Help menu in the product, click About ACT!, and then click
the View End-User License Agreement link.

Printed in the United States of America.

Published by

Sage Software, Inc.

8800 N. Gainey Center Drive, Suite 200

Scottsdale, AZ 85258

(480) 368-3700

10987654321



Contents

Introduction. ... . ... ... ... ... 1
What You Should Know Before Installing ACT! 2010.... 2
Preparingto Install ACTL ... ... ... ..., 5

Installing ACT! for the First Time.._..._..._... .. ... ... ... 7
Installing ACT!forNew Users. ... ................. 7
Registering and Activating ACT! for New Users.......... 9

Installing ACT! for UpgradingUsers...................... 1
What You Should Know Before You Upgrade Your..... 11
Database... ... ... ... ...
Installing, Registering, and Activating ACTL..._..._..__. 15

Upgrading Databases. ... ... .. .. .. ... ..... 17

Installing Other Applications. ... .. ... ... ... ........... 19
Adobe®Reader®.......... ..ol 19
ACT! Premium Synchronization Services................ 19
Handheld Devices Data Sync Software.................. 22

Getting Started for NewUsers. ... ... ... ... ... 23
Creating Databases......................o....o......... 24
Addingusers. ... .. 25

Setting Up ACT! for Use Over a Network _._..._.......... 26







Introduction

Welcome to ACT! by Sage 2010. Whether you are
installing ACT! for the first time (New User) or
upgrading from an earlier version (Upgrade User),
this guide provides information you need to
successfully install ACT! and start using it.

This guide covers installation for:

ACT! by Sage 2010 — Designed for professionals
who work alone or in small workgroups of up to
10* users.

ACT! by Sage Premium 2010 — Designed for
professionals who work in business teams and
workgroups.

When features are exclusive to ACT! Premium, they

are noted in the guide. In most sections, we refer to
both versions as ACT!.

Note: If you are installing ACT! by Sage Premium
for Web 2010, you need this guide and the ACT! by
Sage Premium for Web Administrator’s Guide to
complete installation and configuration of ACT!
Premium for Web 2010. The ACT! by Sage Premium
for Web Administrator’s Guide is available as a PDF on
the ACT! by Sage Premium for Web 2010 DVD.

* Some operating systems may limit concurrent
connections. See System Requirements at
www.act.com/2010systreq.
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What You Should Know Before Installing ACT!
2010

This section contains information you should know
before installing ACT! 2010.

Microsoft® SQL Server® 2005 Express and
required components — ACT! 2010 automatically
installs Microsoft SQL Server 2005 Express Edition,
including Service Pack 3 (SP3). SQL Server 2005
Express requires .NET Framework 2.0 and
Windows™ Installer 3.1 components. These
components are installed if they are not on your
computer.

Microsoft SQL Server 2008 — To install Microsoft
SQL Server 2008 for use with ACT! Premium 2010,
refer to the Installing Microsoft SQL Server 2008 PDF
after following the instructions in this guide. The
Installing Microsoft SQL Server 2008 PDF is available
from the Start Here link on the Microsoft SQL
Server 2008 DVD.

ACT! 3.x, 4.x, 5.x (2000), or 6.x (2004) Users — If
you are upgrading from ACT! 3.x, 4.x, 5.x (2000), or
6.x (2004), you must convert your database to use it
with ACT! 2010. Follow this guide to install ACT!
2010, then see the online Help for information on
how to convert a database.
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E-marketing services by SwiftpageTM - ACT! 2010
includes E-marketing services provided by
Swiftpage, a third-party company. To use these
services, you must subscribe to services and access
content hosted by Swiftpage. IMPORTANT: If you
currently use Swiftpage with earlier versions of
ACT!, you must uninstall Swiftpage before installing
ACT! 2010. You can access your Swiftpage account
after installing ACT! 2010.

Other add-on products — Some applications added
as plug-ins or add-on products in earlier ACT!
versions may not upgrade to ACT! 2010. These
applications may require re-installation after
installing ACT! 2010.

Microsoft Outlook®, Word, and Exce1®
integration — ACT! 2010 integrates with Microsoft
Outlook and several Microsoft Office applications.
The supported versions are:

e Outlook XP, 2003, and 2007 (SP3 is recommended
for Outlook XP and 2003).

« Word and Excel XP, 2003, and 2007 (SP3 is
recommended for Word/Excel XP and 2003. SP2
is recommended for Word/Excel 2007).

If you plan to use the integration features, ensure
Outlook, Word, and Excel are installed and working
correctly. To configure and set up integration with
ACT!, see Help.
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ACT! 2010 Handheld support - If you currently use
ACT! Link for Palm OS® or ACT! Link for Pocket
PC applications with earlier versions of ACT!, you
must uninstall these applications. Then, install the
handheld links software that is supported with
ACT! 2010 and upgrade your database. For more
information, See "Installing Other Applications" on
page 19.
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Preparing to Install ACT!

To ensure a successful installation, all users (new
and upgrade) should complete the following steps
before they install ACT! 2010.

Steps: Prepare to install ACT!

1. Ensure your computer (or all computers if
installing ACT! in a shared environment)
meet the minimum recommended system
requirements for your purchased product
and supported operating systems. Also,
verify you meet the concurrent user limits
and licenses. See System Requirements at
www.act.com/2010systreq.

2. Ensure all computers are up-to-date with
Microsoft critical and recommended
updates.

3. Sign on as a Microsoft Windows
Administrator on all computers.

4. If you use a software-based firewall, you
must temporarily disable it to install ACT!.

5. To install ACT! to a location other than the
default location (C:\Program Files\ ACT\
ACT for Windows), verify directories exist
and folder-sharing rights are enabled.
(During installation, you can select Custom
to install ACT! to a non-default location).
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Note: You can copy the contents of the
installation DVD to a network drive or USB
memory stick for installation on computers
that do not have a DVD or CD drive.

6. To install Microsoft SQL Server 2005
Express to a location other than the default,
ensure the installation folders are unique to
this instance of SQL Server. None of the
directories should be shared with
directories from other instances of SQL
Server. For more information, see
Microsoft documentation.

Next Step(s)
New Users: Install ACT!, see "Installing ACT! for the
First Time" on page 7.
Upgrading Users: Prepare your database for
upgrading or conversion, see "Installing ACT! for
Upgrading Users" on page 11.
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Installing ACT! for the First Time

This section explains how to install, register, and
activate ACT! 2010 for first-time (new) users. If you
have a version of ACT! currently installed, see
"Installing ACT! for Upgrading Users" on page 11.

Tip: To install ACT! Premium in a workgroup
environment without user interaction, you can
install it silently. For more information, see Help.

Installing ACT! for New Users

The installation program automatically checks for
and installs required components. The component
installation may require a restart of the computer. If
a restart is required or components cannot be
installed, a message appears. Follow the
instructions.

Steps: Install ACT! 2010
1. Close all open applications.
2. Insert the ACT! DVD.
or
If you downloaded the software, or are

installing it from another location, double-
click the setup.exe file.

Tip: If the DVD does not automatically
start, you can click the Start menu, select
Run. Type <drive letter>:SETUP. Click OK.
Or, in the Start Search box, type <drive
letter>: SETUP. Press Enter. (Substitute the
appropriate drive letter).
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3. From the browser page that appears, click
Install ACT! by Sage 2010 or Install ACT!
by Sage Premium 2010.

4. Follow the onscreen instructions. Click Next
to continue.

5. During installation, be aware of the
following:

o Youmust Accept the License
Agreement for installation to continue.
(If you Decline, installation is cancelled).

« Typical installation is the default.
However, if you want to change
default settings, select Custom.

6. On the ACT! Install Complete page, select
or clear options. Click Finish.

If you selected the option to launch (start) the
software, when it opens, you can register and
activate the software, or open it in trial mode
for 30 days.

Note: If the ACT! Update message appears,
you may have to click Yes to check for updates.
You can click No to continue with registration
or trial mode.
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Registering and Activating ACT! for New Users

You must register and activate ACT! within 30 days
of first use on each computer where it is installed.
Registration and activation provides you with
program updates, upgrade offers, and customer
support options. A serial number is required to
register. The serial number is printed on the DVD
sleeve or it is e-mailed to you in a purchase
confirmation e-mail. You can register by Internet,
telephone, or e-mail. (Registration by e-mail may
not be available in some locales.)

Note: On Windows Vista®, you must register ACT!
as an Administrator. Close ACT!, right-click the
ACT! icon on the desktop or in the Program Files
list. Click Run as administrator.

Steps: Register and activate ACT!
1. From the Help menu, click Register ACT!.

2. On the ACT! Registration and Activation
Wizard page, select a registration option.
Click Next.

3. Follow the onscreen instructions. Click Next
to advance.

4. When finished, click Activate.

If error messages appear, follow the
instructions.
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Next Step(s)

« To install other applications to use with
ACT! 2010, see "Installing Other Applications" on
page 19.

« To get started using ACT!, see "Getting Started
for New Users" on page 23.
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Installing ACT! for Upgrading Users

The following section is for users upgrading from
earlier versions of ACT!

Users upgrading from ACT! 2005 — 2009: Read
about changes in ACT! 2010 for database upgrades,
see "What You Should Know Before You Upgrade
Your Database" in the next section.

Users upgrading from ACT! 3.x, 4.x, 5.x (2000), or
6.x (2004): You can install ACT! 2010 without
converting your database or removing your earlier
version. See "Installing, Registering, and Activating
ACT!" on page 15.

What You Should Know Before You Upgrade Your
Database

The following sections explain:
« Database upgrade considerations.

« What happens to your data when you upgrade it
to ACT! 2010.

» Items that do not upgrade.

IMPORTANT: If you currently use an ACT!
Premium version and you plan to install ACT! by
Sage 2010, a non-premium version, you must
prepare your database, or downgrade it, to work
with the non-premium version before you install
ACT! 2010. For further instructions, see the
associated Knowledgebase article "How to
Downgrade an ACT! Premium database to ACT!
Standard".
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Database Upgrade Considerations

Note the following considerations before you
upgrade an ACT! database.

« The database upgrade process overwrites your
earlier version database. It is important to have a
backup copy of your earlier version database in
case you want to re-install an earlier ACT!
version. You can perform a back up before the
upgrade process starts.

o ACT! versions 2005 (7.x) and 2006 (8.x) use
Microsoft SQL Server 2000 to manage the
database. ACT! versions 2007 (9.x) and newer use
Microsoft SQL Server 2005. If you are upgrading
from ACT! 2005 or 2006, your database is
upgraded to SQL Server 2005 Express.

o An ACT! Administrator or Manager user can
upgrade a local database.

o An Administrator, Manager, or Standard user (if
there is no active Administrator user) can
upgrade a remote (Subscriber) synchronized
database they belong to.

Note: If you synchronize data between a main
and remote database, it is recommended that
you create a new remote database so that
opportunity data changes in ACT! 2010 (detailed
in the next section) will synchronize. ACT! 2010
allows you to create up to 50 remote databases
at one time.

12 ACT! by Sage 2010



« Database supplemental files, such as templates,
reports, and layouts, do not require upgrading
for use in ACT! 2010

Note: ACT! 2010 includes new layouts with new
fields and features. If you added custom fields to
an earlier version layout, you may want to add
your custom fields to the new layouts. For more
information, see Help.

What Happens to Your Data During Upgrade

In ACT! 2010, Opportunities work in the same way
as Contacts, Groups, and Companies. Opportunities
have a Detail view layout with tabs. When your
opportunities are upgraded, all records appear in
the new Opportunity Detail view layout and tabs.
Also, other new features may affect where and how
you access your existing data. The following items
describe what happens to your opportunity and
other data as it is upgraded. Unless specified, all
existing opportunity data remains the same. All
opportunity customizations and security settings
are retained.

« Contact names assigned to an opportunity
appear on the Contacts tab.

« Groups and Companies associated with an
opportunity appear on the Groups/Companies
tab.

o Details for an opportunity become notes and
appear on the Notes tab.
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» Activities scheduled (using the Follow-up
command) for an opportunity appear on the
Activities tab.

« History information, such as the date opened,
appear on the History tab.

« Opportunity record access (such as public or
private) is retained and appears on the
Opportunity Info tab.

« Internet Services links appear on the Web Info
tab for Contacts and Companies. Favorite links
are accessed from the View menu.

Items That Do Not Upgrade
Note the following items that do not upgrade.

« Menu/toolbar and column customizations.

» ON setting for Accept Incoming Syncs. Only the
port number is retained. (However, it is
recommended that you create new remote
databases.)

o ACT! Premium only: Synchronization services.
(Network and Internet Synchronization
Services). You must uninstall earlier versions, and
then install versions that work with ACT!
Premium 2010, see "Installing Other Applications"
on page 19.

Next Step(s)

Install ACT! 2010, see "Installing, Registering, and
Activating ACT! " in the next section.
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Installing, Registering, and Activating ACT!

This section explains how to install, register, and

activate ACT! for upgrading users.

Steps: Install ACT! 2010

1.
2.

Close all open applications.
Insert the ACT! DVD.

or
If you downloaded the software, or are
installing it from another location, double-
click the setup.exe file.

Tip: If the DVD does not automatically
start, you can click the Start menu, select
Run. Type <drive letter>:SETUP. Click OK.
Or, in the Start Search box, type <drive
letter>: SETUP. Press Enter. (Substitute the
appropriate drive letter).

From the browser page that appears, click
Install ACT! by Sage 2010 or Install ACT!
by Sage Premium 2010.

Follow the onscreen instructions. Click Next
to continue.

During installation, be aware of the

following:

« You must Accept the License
Agreement for installation to continue.
(If you Decline, installation is cancelled).
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« Typical installation is the default.
However, if you want to change
default settings, select Custom.

6. On the ACT! Install Complete page, select
or clear options. Click Finish.

If you selected the option to launch (start) the
software, when it opens, you can register and
activate the software, or open it in trial mode
for 30 days.

Note: If the ACT! Update message appears,
you may have to click Yes to check for updates.
You can click No to continue with registration
or trial mode.

Steps: Register and activate ACT!
1. From the Help menu, click Register ACT!.

2. On the ACT! Registration and Activation
Wizard page, select a registration option.
Click Next.

3. Follow the onscreen instructions. Click Next
to advance.
4. When finished, click Activate.
If error messages appear, follow the
instructions.

Tip: ACT! 2005 - 2009 serial numbers are retained on
the computer if you need to re-install the earlier

version.
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Next Step(s)

Upgrading from ACT! 2005-2009: Upgrade your
database, see "Upgrading Databases" in the next
section.

Upgrading from ACT! 3.x, 4.x, 5.x (2000), or 6.x
(2004): See the online Help for information about
how to convert your database for use with

ACT! 2010.

Upgrading Databases

The following explains how to upgrade an ACT!
database.

Steps: Upgrade a database
1. Open ACT!
2. From the toolbar, click Open Database.
In the Open dialog box:

a. Locate the folder that contains the
database.

b. In the Files of type list, select ACT!
Database (*.PAD) or ACT! Database
(*.ADF).

c. Select the database. Click Open.

4. Follow any update and verification prompts
that appear.

5. At the update process complete status
message, click OK.
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If a workgroup shares the database, make
sure all users install ACT! 2010. Then, you can
distribute a shortcut to the PAD file for the
database.

Next Step(s)

o To create new remote, synchronizing databases,
see Help.

» To install other applications for use with
ACT! 2010, see "Installing Other Applications" on
page 19.
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Installing Other Applications

This section describes the other applications you can
install with ACT!. These applications include:

. Adobe® Reader®

» ACT! Synchronization Services (ACT! Premium
only)

« Handheld Devices Data Sync Software

Adobe® Reader®

To view product documentation (accessed from the
ACT! DVD browser and ACT! application), you
must have Adobe Reader installed.

Steps: Install Adobe Reader

1. From the ACT! 2010 DVD browser, click
Product Documentation.

2. Click the link to go to the Adobe Web site.
3. Download and install Adobe Reader.

ACT! Premium Synchronization Services

ACT! Premium offers two synchronization services
so remote database users can synchronize their data
to a main database. You can install one or both
services depending on your users' needs.
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Network Synchronization Service — Used to
synchronize ACT! Premium databases over a
network. The service is designed for remote users
connected to the main database via a Local Area
Network (LAN), Wide Area Network (WAN), or a
Virtual Private Network (VPN), when the main
database is not open. You can install the ACT!
Network Synchronization Service on the same
computer as ACT! Premium or on another
computer.

Internet Synchronization Service — Used to
synchronize ACT! Premium databases over the
Internet when the main database is not open. This
service requires a computer (located outside the
firewall) with ASP.NET and the following versions
of Microsoft Internet Information Services (IIS)
installed for your operating system:

o Windows XP-1IS 5.1

« Windows Server® 2003 - IIS 6.0
« Windows Server 2008 —IIS 7.0

o Windows Vista-1IS7.0

Note: If you use a 64-bit operating system, you must
set IIS 7.0 to run in 32-bit compatibility mode. For
information about how to do this, see Microsoft’s
online Help.

For more information about synchronizing
databases, see Help.
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IMPORTANT: If you install the ACT! Internet Sync
Service on a machine which does not have ACT!
Premium installed, ensure the <machine

name>\ ASPNET account has read/write permissions
on the Internet Sync install folder. Or, if you move
the SyncConfigFile.xml to another folder on your
machine, edit the location settings in the file. For
more information, see Help.

Installing the ACT! Sync Services

The following section explains how to install the
ACT! Sync services.

Steps: Install the ACT! Sync Services
1. Insert the ACT! DVD.
2. Click Install ACT! Synchronization
Services.
3. Do the following;:

« To install the Internet Sync service on
the IIS computer, click ACT! Internet
Synchronization Service.

« To install the Network Sync service,
click ACT! Network Synchronization
Service.

4. Follow the onscreen instructions. Click Next
to advance. Click Finish.

For information on setting up the Sync services, see
Help.
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Handheld Devices Data Sync Software

You can send and receive data, such as contact
records, between your ACT! database (main or
remote) and handheld device.

Software for synchronizing data with handheld
devices is available and can be installed with any
version of ACT!:

« ACT! Link for Palm OS® — Used to send and
receive ACT! data to/from a Palm OS handheld
device.

« ACT! Link for Pocket PC — Used to send and

receive ACT! data to/from a Pocket PC handheld
device.

Note: The ACT! Administrator must assign the sync
permission to let you synchronize data with a
handheld device. For more information, see "What
Are User Roles and Permissions?" in Help.

For installation, configuration, and usage
information, see the Quick Start for Handheld Links
and Help systems. To see a feature tour on how to
install the links, under Product Documentation on
the Installation DVD, click Handheld Installation
Tour.
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Getting Started for New Users

To help you get started using ACT!, you can read
the Quick Start for New Users Guide and view the
Feature Tours (accessed from the Help menu). You
may want to practice entering data using the
demonstration database, ACT2010demo, which is
installed with ACT!. This database contains sample
records and activities.

To set up ACT!, you need to create a database for
your contacts' information. If you want to share the
information with others, you need to add them to
the database as Users. The ACT! Setup Assistant
walks you through setting up ACT!.

The following sections:

« Describe the Setup Assistant.

« Provide the steps to create a database and add
users.

o Show you how to set up ACT! for use over a
network.

About the Setup Assistant

When you open ACT! for the first time, the Setup
Assistant appears. You can use this wizard to create
a database and set default preferences and other
options so you can quickly start managing your
contacts and information.

The Setup Assistant is also available from the Help
menu and on the Welcome page under Getting
Started. Click Set Up Preferences and E-mail.
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Creating Databases

The following explains one way to create an ACT!

database. If you know others will need access to the

data, you can share the database. Once the database
is created, you add the people requiring access as

Users.

Steps: Create a database

1.
2.

From the File menu, click New Database.

In the Database name field, type a name for
the new database.

The name must begin with a letter. Do

not include spaces or punctuation.

In the Location field, keep the default
information.

or

To save the database to a different location,
click Browse to browse to the location.
Click OK.

In the Currency field, from the list, select a
currency for the database.

To share the database with others, select the
Share this database with other users check
box.
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6. In the User name field, type a user name
for the database. (This step creates a contact
record known as My Record and in most
cases, this will be your name. This contact is
given the Administrator security role.)

7. To set alogon password for the database, in
the Password field, type a password and
type in again to confirm.

Caution: If you forget this password, you
will not be able to access the database. You
will have to contact Technical Support.

8. Click OK.

ACT! creates the database and a file that
points to the database. This file has a PAD
extension. If you share the database with

others, you can send them a shortcut to
the PAD file so they can access the
database.

Tip: For more information, see "Sharing
Databases" in Help.

Adding Users

If other people need access to the database, you
must add them as Users. You can assign them
security roles and permissions to limit their access
to data and ACT! features.

Note: You can add any number of users. However,
you are limited by your license for the number of
users that can be active.

Installation Guide 25


../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/What Is My Record.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/What Is My Record.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/User_Teams/What Are User Roles and Permissions.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/User_Teams/What Are User Roles and Permissions.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/User_Teams/What Are User Roles and Permissions.htm

Steps: Add a user

1.
2.

From the Tools menu, click Manage Users.

On the Select a User page, under User
Tasks, click Create New User.

On the Create New User page, select an
option for the source of the user
information. Click Next.

Complete the User Name, Security Role,
and Password fields on the Enter User
Information page. Click Next.

On the Specify Access page, select a logon
access option. Click Next.

On the Add Permissions page, use the
arrow buttons to add or remove
permissions for the user.

Note: By default, some permissions are
added for the user because of the security
role selected for him or her.

Click Finish.

Setting Up ACT! for Use Over a Network
The following explains how to set up an ACT!

database to be used over a local area network
(LAN) or a virtual private network (VPN).

Note: If you do not use the server (host) computer
to access the ACT! database, you can use the same
serial number for a client computer.
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Steps: Set up ACT! on a network

1.

Ensure each computer (host and clients) has
a licensed copy of ACT!.

Verify each computer has the same version
of ACT! installed.

Tip: To check the version: From the Help
menu, select About ACT!. The version
number appears at the top of the page.

Add ACT! to the list of firewall exclusions.
Refer to Windows Help for more
information.

On the host computer, do the following:
a. Create a database and share it.

b. Add users to the database.
Close ACT!.

To set sharing rights, permissions for

n

a

full read/write access, and full security
rights to the database folder and its
supplemental files for all users, browse
to the Databases folder. Set sharing,
permissions, and access. By default, the
Databases folder is installed to:

« Windows XP or Windows Server
2003 — C:\Documents and
Settings\[Current user]\My
Documents\ACT\ACT for
Windows 12\ Databases.
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e.

« Windows Vista —
C:\Users\Documents\ACT\ACT
for Windows 12\ Databases.

« Windows Server 2008 —
C:\Users\[Current
user]\Documents\ ACT!\ ACT for
Windows\Databases

To allow sharing of personal
supplemental files, such as saved
documents, Internet links, and
dictionaries between users, create a
shared folder for each type of data and
allow full control to all users.

Copy the database's .PAD file to a
network location that you can access
from each client's computer or to a USB
memory stick.

Note: For more information about

database supplemental files and personal

supplemental files, see Help.

5. On each client computer, do the following:

a.

Browse to and open the Databases
folder. (See locations in step 4d).

Paste the .PAD file copied from the
host computer.

Double-click the .PAD file to open the
database.
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d. To share the user's saved documents,
Internet links, and dictionaries, change
the Preferences setting: From the Tools
menu, select Preferences. On the
General tab, in the Personal Files
Locations, change the locations to the
shared folders on the host computer.
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